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Looking at My Computer 
 

Words in this lesson:  

 

Hardware is the part of the computer that you can touch and see. 

The five main parts of hardware are: 

  

 

Monitor 

 

 

 CPU (Central Processing Unit – the brain) 

 

 

Mouse 

 

Keyboard 

 

 

Printer 

Hardware    Monitor    CPU 

Mouse    Printer   Keyboard 
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What do all the parts do? 

 

Hardware 
 

What it does 

 
 
 
 
 

 
The monitor of the computer 
looks like a TV screen. It shows 
you pictures and information 
from the computer. 
 

 
 
 
 
 
 

 
The CPU is the thinking part of 
the computer. It is the computer’s 
brain. 

  
The mouse is used to select or 
move items on the screen. 
 

 
 
 

 
The keyboard allows you to type 
words and numbers into the 
computer. 
 

 
 
 
 
 

 
The printer makes a paper copy 
(also called a hardcopy) of 
something from the computer. 
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How do I turn the computer on? 

 

A desktop computer sits on a desk.  

A laptop can rest on your lap. 

A laptop is a good computer to get if you need a 

computer you can carry to the couch or the kitchen 

table or to a coffee shop. 

A laptop bag helps keep your laptop safe. 

*Note: A Chrome book is different than a laptop. It runs on a Google 

operating system (not Windows) and is not a full computer. 

The On button turns the devices on and off and looks like this: 

A desktop computer will have an On button, and the monitor that is 

attached to it will have a separate On button. 

The On button for the monitor may be on the front or 

the back, and it looks like this: 

On a laptop, the On button is a button on the side or on 

top of the keyboard. Hold this button 

down to turn your laptop and screen on. 

This button turns on the laptop: 

 

 

 

 Please finish pages 3, 4 and 5 of 

your workbook. 



9 
 

How do I use the mouse? 

Words in this lesson: 

Select – a way of choosing something on the computer by clicking on it 

with the mouse. 

Shortcut – a way of doing something that saves time. 

Scroll – a way to move around the computer screen. 

Highlight – a way of selecting a word or words. 

 

Use the mouse by putting your right hand on top 

of the mouse with your fingers over the buttons.  

Use your index finger (finger beside your thumb) 

to click LEFT.  

Use your ring finger (finger beside your little 

finger) to click RIGHT. 

 

The mouse rolls.  

When you move the mouse, you will see the pointer 

move on the screen.  

To move up and down the page, use the wheel 

button on the mouse. 

Button     Highlight      Select 

Shortcut      Scroll      Wheel 

Scroll       
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How do I highlight words with my mouse? 

How to highlight words: 

• Place the pointer at the beginning of the words you want to 

select. 

• Put your first finger on the left mouse button. 

• Hold down the left mouse button. 

• Move the mouse across the words.  

• Lift your finger. 

How to highlight a sentence or paragraph: 

• Two clicks (double-clicking) on a word highlights the word and 

clicking on it three times will highlight a full line or paragraph of 

text. 

How do I use the keyboard? 

 

Words in this lesson: 

  

 

 

 

(Following keyboard lesson, credit: Essential Skills for Word Processing 2016, TR Leger School 

STEP Program, UCDSB) 

The arrow keys on your keyboard move the pointer around. 

 

Key    Arrows   Shift 

Enter    Backspace   Delete 

Space   Home   End 

 

https://www.computerhope.com/jargon/w/word.htm
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The arrows move this way:  

    

 

 

 

To make a letter a capital letter, 

hold down    and the letter key at the same time. 

 

For the signs on your keyboard,  

 

 

hold down                     and the number key                 at the same 

time. 

 

The shift keys are on both sides of the keyboard. 

 

Shift keys 

 

The Spacebar makes a space. 

 

Use the                           key to start a new paragraph.  

                                                            

 
UP 

DOWN 

RIGHT LEFT 
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                      The Backspace key deletes the character to the left of the 

pointer.  

  

The                 key will erase the character to the right of the pointer. 

 

To make the cursor go to the end of the line, press the End key. 

   

To make the cursor go to the start of a line, press the home 

key. 

 

How do I sign into the computer? 

Words in this lesson: 

 

When you turn on the computer, you may see a 

screen something like this, asking for a User name 

and a Password. 

You sign in to a computer to use it. 

If you have a user name and password, you will type 

it in here. 

People put passwords on computers to keep what they do safe. 

Screen   Desktop   Sign in 

Username   Password   Operating system 
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A computer with an old operating system may not need you to sign in. 

An operating system is the program that runs your computer. Windows 

is an operating system. Apple computers use a different operating 

system. 

You will see the desktop after you sign in. 

The desktop will look different on each computer. 

The desktop has icons (pictures) of apps, programs, and folders. 

 

Activity #1 – Turn On Your Computer and Sign In 

Turn on your desktop or laptop computer. 

 

1. Sign in using your username or username and password. 

 

2. Look at what is on the screen of your computer. 

 

3. Look at the icons (pictures) on the desktop and the words under 

them. 

 

 

 

 

  
Ask your 

instructor about 

Milestone #54 

  Please finish 

pages 6, 7 and 8 of your 

workbook. 
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How do I turn the computer off? 

Look for the Windows icon at the bottom left of your screen.  

Click on it. 

You can choose to sign out or turn off your computer. 

 

 

 

  

  sign out 

 

 

  turn off 

 

If your computer is older, it might look different. 

Click on the Sign out button or the Shut down button. 

The computer will ask you if you want to sign out.  

 

This is a safer way to turn off the computer than to use the power 

button. 
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Looking on the Internet 
Browsers are used to go on the Internet. 

Here are some Internet browsers: 

 

You can click on your Windows button to see them.  

We will be using Google Chrome to search online later in this book. 

 

Click on the Google Chrome icon to go online.  

 

How do I search for apps and folders? 

Words in this lesson: 

 

 

 

Documents and pictures are saved on the computer in folders. 

Folder icons (pictures) on the computer look like these:  

You can click on a folder to see what is inside. 

Apps    Button     Icon 

Internet   Program         Web-based 
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Desktop applications (programs) are also on your computer. 

Click on the Windows button on your screen to see your apps.  

The Windows button is also on some keyboards.  

Apps are programs that help you do 

different tasks and are sometimes just for 

fun.  

Apps have icons (pictures) to show you 

what they do.  

 

Desktop apps have been installed on (put on) your computer. 

Some apps are web-based apps and will need the Internet to run. Some 

web-based apps are: 

   Facebook     Google Mail        YouTube     Google Play       Twitter 

If you cannot find the app or folder you need on the screen, you can 

search for it.  

If you do not see the search box at the bottom of the screen, click on 

the Windows icon to see it.  

Type the name of the app you are looking for and press the Enter key 

on the keyboard.  

  

  Please finish 

pages 9 and 10 of your 

workbook. 
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Activity #2 – Search for an App 

 

Go to the search box, type the word Notepad, and then click on 

Notepad. 

. 

 

 

 

 

 

 

 

Click on a spot on the desktop where there are no icons (pictures).  

The search window will close. 

Activity #3- Search for the Documents Folder 

 

1. Click on the search box. 

2. Type documents. 

3. Find the Documents folder. 

4. Click on a spot on the desktop where there are 

no icons (nothing) to close the search box. 
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How do I search for a website? 

Words in this lesson: 

Search engines help you find information online. 

Google is a search engine used by many people. 

There are other search engines as well, like bing.com, msn.com and 

yahoo.ca, and DuckDuckGo. 

In this book, we will be using Google. 

When you click on the Google Chrome icon, the browser will 

open on the Google home page. 

A home page is where you start on the Internet. 

The address bar is used for searching online. 

It is at the top of the screen. 

 

Click in the box to highlight the address, then type over it with your 

new web address. 

 

 

You will get a list of items that match your search.  

Address bar    Browser    Chevron  Drop-down 

Internet    Home page  Online   Search engine  
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What is a link? 

The hand pointer looks like this:   

When the arrow pointer changes to a hand, it indicates the presence of 

a link.  

Selecting the link will take you to another document for further 

information (or to another place in the current document).  

A link is often indicated by a different colour and by being underlined. 

 

What is a drop-down menu? 

A drop-down menu shows options dropped down in a list. 

You are asked to choose one option from a list. 

A drop-down menu looks like this: 

 

 

To pick something from the box, click the down arrow. 
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Use your wheel button to move up and down through the items in the 

list. 

Click on the one you want.  

There will be a bar on it to show you have picked it. 

How do I see more of the page? 

You may need to move up and down or side to side to see a whole 

webpage. You can do this by scrolling.  

Use the scroll bars to move the page. 

Scroll bar on the right and bottom of your screen 

 

. 

 

 

 

 

 

Click on the up arrow to move up the page.    

Click on the down arrow to move down the page.  

Or use the wheel on your mouse to scroll up and down in a document.    

  

down 

up 
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Activity #4 – Use the Mouse Online 

Open your browser. 

 

1. Go to the Google search box, type in Mouse Aerobics. 

 

 

 

 

2. Pick one of the blue links. 

 
 

3. Follow the instructions to practice using a mouse. 

 

4. Let your instructor know when you are done. 

 

5. Go to the Address bar, type in google.ca, and search Mousercise. 

 

6. Click on Mousing Around: Moucercise, and follow the instructions 

there. 

 

*If you want more practice at using a mouse, search for another 

link. 
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How do I print part of a page on a website? 
 

If you print from the 

Internet you can have a 

lot of pages. Ads and 

other text you do not 

want can print out too. 

If you highlight only 

what you want and 

print it, you will save 

paper. 

 

You can do this in Google Chrome. 

Type this web address: 

https://www.ontario.ca/page/employment-ontario 

Instead of printing the whole article, select (pick) the information you 

want by highlighting it with your mouse. 

Highlight the top part of this site. 

 

 

 

 

 

 

https://www.ontario.ca/page/employment-ontario
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Left click at the start of the word Employment and highlight by holding 

down your finger (drag) on the left mouse button and moving your 

mouse down to the workers (see example on page 22). 

Lift your finger when you are done. 

Right click on the blue highlight. Make sure you use the button on the 

right side of the mouse and that you click right on the highlight. 

 

Select (pick) Print. 

You will see a screen showing you just this part of the site. 

 

Click Print. 

Activity #5 – Print a Recipe 

1. Go to Google.com. 

2. Type cookie recipes and pick a cooking website. 

3. Practice highlighting recipes holding down the mouse or by clicking 

on the same spot three times. 

4. Click on the page away from the highlighted words to make the 

highlight go away (deselect). 
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Activity #6 – Print a Picture of Puppies 

If you want to print just a picture (image 

from the Internet) you can right click on it 

to print. Right clicking on a picture gives 

you options, like print, save or copy. 

1. Type in Google.com.  

2. Type puppies in the search box. 

3. Click on Images for puppies. 

 

4. Look at the images (pictures) of puppies. 

 

5. Click on one. 

6. Right click on the picture to get your options. 

7. Pick Open image in new tab. A tab will show up at the top of the 

screen. 

8. Click on it.  

9. Click on the three dots in the right corner. 
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10. Pick 

Print. 

 

11. Print 

picture. 

 

 

 

How do I go back to where I was? 

 

 

You can go backward and forward on the Internet as if you were 

turning pages in a book. 

If you do not close your screen, you can use the arrows to go back to 

where you were before. 

 

Click the   back arrow at the top, left corner of the screen to go 

back. 

 

It will take you back one page. 
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If you would like to go to the page you were on, click the  

forward arrow at the top left corner of your screen. 

You can move back and forth from webpage to webpage using these 

arrows. 

 

Activity #7 – Turn the Page 

 

 

 

 

 

1. Use your back arrow to go back to Google from your Mouse 

Aerobics page. 

2. Click the forward arrow  to go back to the Mouse Aerobics 

page. 
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Looking at a Website 
Words in this lesson: 

 

 

 

You can use these 5 tips when reading a website: 

1) Look at all the titles and headings on the page. 

2) Only read the parts you need. You do not have to read it all. 

3) Try not to click on ads or commercials on the page. 

4) Scroll to see the whole page. 

5) If you click on a link you do not like, use your back button to get 

back. 

 

  

 

The pointer will let you know where you can click on a webpage. 

The arrow will change into a pointing hand. 

 

Ads 
Heading

s 

Links 

Ads  Bookmark  Headings  History  

Link  Slide   Titles 

  

http://personal.psu.edu/jmw5737/art003/class10/page3.html
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How do I save my place? 

If you find a site you like you can save it. Saving a website is called 

bookmarking. 

Click on the star to bookmark the site you are on. 

 

 

 

 

Click on Done. 

 

 

 

How do I see my bookmarks? 

 

Click on the 3 dots on the right.   A menu will drop down. 

Click on Bookmarks. 

 

 

Your bookmarks will show up on the left. 

Use your mouse and slide straight across.  

Click the page you want to save (bookmark). 
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Activity #8 – Find Your Postal Code 

Go to the address bar. 

 

1. Highlight the address in the bar by clicking on it. 

 

2. Type in www.canadapost.ca

 
 

3. Use the Enter key on the keyboard. 

4. Choose English. 

 

5. Click on Find a Postal Code. 

 

6. Type in your street address and town in the search box. 

 

 
7. Click Search or pick your address from the drop-down box. 

 

8. Look for your postal code.  

    9.  Bookmark this site. 
Ask your 

instructor about 

Milestone #55 

http://www.canadapost.ca/
http://www.canadapost.ca/
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How do I go to other places? 

You can keep what you are working on and still go to other places on 

your computer. 

The name for keeping a page but moving it out of the way is called 

“minimizing.” 

Minimizing a screen does not close it. It sends it to the bar at the 

bottom of the computer. 

To minimize a screen, click the line at the top right of 

your page. 

To open it back up, click the program icon in the bar at the bottom of 

the screen.  

 

 

Activity #9 – Minimize the Page 

1. Minimize your Internet page. 

2. Click on the Google Chrome icon to bring it back up.  

3. Minimize it again. 

4. You will need to on the desktop for the next part of this book. 

  

 Please finish page 11 of your 

workbook. 
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Looking for a Job  
 

Many people look for work online. 

There are job search websites like the job bank and Indeed.ca 

Some employers look for workers on Kijiji and Facebook. 

Employment Ontario has places where you can go for job and computer 

help. 

To find one near you, you can type this web address into your address 

bar: 

http://feats.findhelp.ca/eng/search.html 

Search for a job centre near you. 

 

The search will tell you what job centres are in your area. 

Activity #10 – Search for a Job 

1. Search your town or city on the job bank 

https://www.jobbank.gc.ca/home. 

2. Click a job and then use the back arrow to go back to the job list. 

http://feats.findhelp.ca/eng/search.html
https://www.jobbank.gc.ca/home
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Learning about Folders and Images 

How do I create a new folder? 

In this lesson, you will create (make) a folder for new pictures. 

Right click on a blank space (where there is nothing) on 

your desktop. 

Click on New and slide across to the menu that shows up. 

Click on Folder  

 

 

 

 

 

A new folder will show up on the desktop. 

Click in the blue square and type New Pictures, then press 

the Enter key on your keyboard. 

 This is where you will be saving pictures for this lesson. 
 

How do I save a picture from the Internet? 

Click on Google Chrome at the bottom of the screen. 

Type in www.google.ca.  

Type the word sunset in the address bar. 

Click on Images. 

http://www.google.ca/
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Click on one of the pictures of a sunset.Right click on the image you 

picked.  

Click on Save image as. 

 

 

 

Click Desktop and your New 

Pictures folder. 

 

    

 

 

 

Click in the box beside file name and type Sunset. 

Click Save. 

 

Activity #11 – Save Pictures to a New Folder 

1. Go to the Google search box and type koala bear. 

2. Click on a picture (image) you like. 

3. Right click and pick Save image as… 

4. Click on your New Pictures folder on the desktop. 

5. Click beside the file name. Type the word Koala to rename the file 

and click save. 
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6. Go to the Google search box and type good day. 

7. Click on Images. 

8. Click on a good day image that you like. 

9. Right click and pick Save image as… 

10. Click on your New Pictures folder on the desktop. 

11. Rename the image good day and save. 

 

How do I look at my saved images? 

You can right click in a file to change how you see what you have saved. 

Click on a folder. 

 

Right click on a blank, white space to see options. 

 

Click on View. Slide your mouse over. 

You can move items into a list or see them as icons 

(called thumbnails when they are in a list). You can pick 

the size. 
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You can sort your items into alphabetical (A-Z) order or by date. 

Right click on Sort. Slide over. 

Pick how you want to sort the items in your file. 

 

 

 

 

 

 

What is the difference between files and folders?  

One image is a file. 

A document is also a file.  

Folders can hold many files. 

You can create folders for 

your files just like you did on 

page 32. 

Creating a folder is an option that you get when you right click your 

mouse. 

You can make a new folder (right click your mouse) on a USB, in 

documents or on the desktop. 

You can pick the new folder to save your files, left click on New to 

create the folder. 
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Learning about Email 
Words in this lesson: 

Google has a free email service called Gmail. 

If you do not have an email address now, you can get one on Google. 

You need to sign up for it.  

 

 

How do I get a Gmail account? 

Pick an email name and a password you will remember. 

Go to the address bar and type 

gmail.com. 

 

 

 

Click on Create account. 

 

 

 

Click in each box. 

Account  Address  Compose  Contact   Create 

Email   Folder  Forward   Gmail  Reply 

Send   Theme  Video Chat 

    

 

 Please finish pages 12 and 13 of 

your workbook. 
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Type in your first name and last name. 

Pick a username. There are many used ones. It will take 2 or 3 tries to 

get one. 

Pick a password with 

letters and numbers. You 

will type it twice.  

Click on Next. 

Type your phone 

number. 

 

Click the drop-down 

boxes to give your 

birthdate and gender. 

 

 

 

Click Next. 

Click Not Now when asked to have a 

number sent to your phone. 

Scroll down and click I agree. (Read the agreement first. Ask for help if 

you need it) 
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Google has pages of information about 

Gmail.  

 

 

 

 

 

Click Next to look at the next page.  

Click Go to Gmail.  

 

 

 

You will see this screen. 

This is your email. 

 

 

You can use this to send emails and video chat (to see someone on the 

screen while you are talking to them).  

You can check your email on computers, iPads, iPhones, and Android 

phones. 

Google helps you set up your email. 
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Activity #12 – Set Up Your Gmail Account 

After you have signed up for a Gmail account: Set up your email. 

 

1. Click on Choose a Theme to set up your theme.  

 

2. Scroll down to see all themes. 

 

3. Click the one you like. 

 

4. 6. Click on the X on the right to close. 

 

5. Click on Learn How to Use Gmail. 

 

6. Scroll down to look at 

the tips. 

  

 

 

9. Then click the X to close. 

10. Click on the X to exit. You have done everything you need to do for 

now.  
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How do I write and send an email? 

All email addresses have an “at” sign @. You are writing to someone at 

his or her email site. 

Writing an email is called composing it. After you have written the 

email, you send it to the other person. 

This is what the screen might look like when you are writing an email to 

someone. 

To:   JuniperBurnaby@mail.ca 

Subject Interview on August 12th 

  

Greeting Dear Mr. Burnaby, 

 (space) 

Message 
(State who 
you are. 
Write what 
you want 
the person 
to know.) 

This is Hannah Myers. Your office assistant called me 
and asked me to email you about our interview on 
August 12th. I can come to the interview at 2pm on 22 
Main Street East.  
 
Thank you for your time. 

 (space) 
Closing Sincerely, 

Your Name Hannah Myers 

 

To starting writing an email, click Compose. 
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You will see this:   

Click on To: and type in the email address of the person you are 

emailing.  

 

 

 

Click on Subject and say what your 

email is about (for example, "Hello 

from Angela"). 

 

Click in the big, 

white box to write 

your email.  

Read it over to 

make sure it is ok.  

 

 

Your Sent Mail folder keeps all the emails you have written. 

Click Sent Mail to see if your email is there. Click Inbox to go back to 

your list of emails. 

 

Write message here. 

Click Send. 
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Activity #13 – Sending Email 

1. Ask someone for her or his email address (friend, classmate, or 

teacher). 

2. Write that person an email (compose). 

3. Click Send. 

4. Check your Sent Mail folder to see that your email sent. 

 

How do I reply to an email? 

Click on the sender’s name in your inbox. 

It will open your email. 

 

 

Read your email. 

Look at the bottom of 

the message for 

Reply. 

Click Reply. 

 

Write your reply in the box that shows up. 

Read it over. 

 

Click Send. 
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Gmail will keep all emails in one place so you can see what you have 

said. 

You can forward an email. Forward means you send an email that you 

have received to someone who did not send it to you. 

Click Forward. It is under the email beside reply. 

 

 

 

 

 

 

Type in the email address and click Send. 

 

*Note: You can type a message in the box before you forward if you 

want. 

Activity #14 – Reply to Email 

1. Give someone your email address. 

2. Ask them to send you an email. 

3. Reply to that email. 
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How do I add someone to my list? 

Have someone's email address ready. 

On the top right of your screen when you have Gmail open, 

go to the round circle that has nine little squares in it. This is 

called the waffle icon. 

Click on it. It will open up and show lots of icons. 

Click Contacts. 

 

 

Click on Add a Contact or click the red circle with the 

plus sign. 

 

 

 

 

 

Be sure to fill out the first name, last name, and email. You can add 

other details if you want. 

Look it over to make sure it is right.  

Save.  
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Click on Add new contact again to add more contacts if 

you want. 

Click on the waffle (Google app) icon to open it up, 

then click on the Gmail icon to go back to Gmail.  

Click on Compose to write an email. 

Click on To in the compose screen. 

 

 

Click the checkbox beside the person you 

want to mail.  

 

 

 

Click Select. 

 

Your contact is now in the email. 

If you want to send the email to more than one contact, click 

more than one checkbox. 

Then click Select. 

Write the email to your contact. 

Add a subject. 

Send your email. 
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Want to learn more about email? 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

How do I send a picture in an email? 

You can attach a picture or document to your email and send it to 

someone else. These are called attachments. 

You send an attachment by clicking on the paperclip icon beside the 

Send button at the bottom of your email. 

 

 

Type these websites into your address bar: 

https://youtu.be/AGiFkJDwG-k 

https://edu.gcfglobal.org/en/gmail/ 

Learn when to use reply all, visit: 

https://www.lifewire.com/do-not-default-reply-all-1173272 

 

 

 

 

Ask your 

instructor about 

Milestone #1 

 Please finish page 14 of 

your workbook. 

https://youtu.be/AGiFkJDwG-k
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Activity #15 – Send an Email with a Photo to Yourself 

1. Sign into your email and click on Compose. 

2. Type your email address beside To: (Yes! You are sending this email 

to yourself). 

3. Your subject will be: Test. 

 

4. Write a message to yourself. 

5. Click on the paperclip beside Send. 

6. Click on Desktop, and click on your New Pictures folder. 
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7. Click on one of your pictures and then click Open. 

8. Send your email. 

9. Go to your Sent folder and open the email you just sent to see your 

attachment. 

 

*Try this again with a Word or Notepad document that you have saved 

to your USB. 
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Learning about Places to Use a Computer 
Employment Ontario has places where you can go for job and computer 

help. 

To find one near you, you can type this web address into your address 

bar: 

http://feats.findhelp.ca/eng/search.html 

Search for a job centre near you. 

 

The search will tell you what job centres are in your area. 

Libraries have free Wi-Fi and public computers that you can use. 

 

You can talk to them to find out how to get time 

on the computers there. 

Do not be afraid to try new things out on your 

own now that you know so much about 

computers. 

Your instructor will know of more programs you can try if you want to 

learn more.  
 Please finish page 15 of your 

workbook. 

http://feats.findhelp.ca/eng/search.html
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Learning about Google Maps  
 

Go to your address bar. 

Type in https://www.google.ca/maps/ or go to Google and search for 

Maps. If you use the search box, find the blue link for Google Maps and 

click on it. 

 

 

 

To find a town or city, type the 

name into the search box.  

This will take you to a map of 

the area.  

 

 

 

 

 

 

 

 

 

 

 

 
 

 

You can see a closer view by 

zooming in, or a larger map by 

zooming out using the + or – 

buttons. 
Zoom 

IN 

Zoom 

OUT 

https://www.google.ca/maps/
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Activity #16 – Find Directions on a Map 

 

1. Click on Directions.  

2. This will open two boxes, one for where you are starting 

and one for where you want to end up. 

3. Type in where you want to start and where you want to 

end. 

4. Press the Enter key and you will see a map and text that will tell you 

how to get where you are going. 

5. You can print these if you need to take them with you. 

 

How do I print directions? 

Click the three dots on the top right. Pick Print from the drop-down 

menu. 

 

Click Print. 
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Learning about Facebook 
Social media sites are places you can share your life with other people 

online. There are many social media sites. Three popular sites are: 

Facebook, Twitter, and Instagram. 

Before you start using one of these sites, there are a few things to  

think about.  

Remember this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

✓ Bosses sometimes search on social sites to see what people 

are like before giving them a job. 

✓ Some posts can be seen by everyone. 

✓ People who can see your posts (what you put online) and 

pictures, can save them to their own computers and keep 

them. 

✓ Set your privacy settings so only people who you want to see 

your site will be able to (see below for instructions on how to 

do this). 

✓ Your social website can show in a Google search if someone is 

looking for you. 

✓ There are people that lie online and use these sites for 

criminal behaviour. 

✓ Anything you put online can be used in a court of law (since it 

is all public). 

✓ What you put online stays online forever! 

✓ People can use the Internet for bullying or to write mean 

comments. 
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A lot of people are on Facebook. It has over 2 billion users. If Facebook 

was a country, it would be the biggest country in the world. 

  

Maybe someone has asked you if you are on it. 

If you want to join it, this lesson will show you how. 

Facebook is a place to share information about your life. 

It is also a place to find people you know and connect with them. 

You can use Facebook for many things. 

There are 4 main uses of Facebook. 

1. Sharing updates (what is new with you) and seeing a friend’s post. 

2. Sharing photos and videos online. 

3. Joining groups and following pages. 

4. Sending messages. 

How do I get a Facebook account? 

Words in this lesson: 

Type www.facebook.com 

Comment   Friend   Home   Like   

Post    Privacy   Profile   Settings  

Share   Status  Wall   

http://www.facebook.com/
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You will see this screen: 

Type in your first name, last name, your new Gmail 

address 

and choose a password. 

Click on Sign Up. 

Click Connect to Gmail to confirm your 

email. Choose your account. 

Facebook will ask if you want to find friends 

from your Gmail contacts.  

You can say yes or just add people later.  

Click Find Friends to use people from your 

email contacts or Next to move on. 

 

How do I add a picture to my my Facebook profile? 

When people look for you they will see a picture. This is called a profile 

picture. 

Click Add Photo to pick a picture for your 

Facebook. 

Your This PC (computer) window will 

open. 

Click on Desktop and click on the New 

Pictures folder. 

Use the koala picture you saved. 

Click Open. 
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This will be your picture for now. 

*You can change your profile picture any time you want. 

 

Activity #17 – Add a Cover Photo on Facebook 

1. Click on your name to see your profile. 

2. You will be asked to pick a cover photo. 

3. Click on  Add Cover Photo. 

4. Pick Upload Photo from the drop-down menu. 

5. Click Desktop and your New Pictures 

folder. 

6. Pick your sunset picture. 

What is a news feed? 

Your profile is all about you, your 

posts, and pictures. 

Your news feed will show you what is going on with your friends and 

pages on Facebook. 

Click on your name to go to your profile. 

Click on Home to see what the top stories of your friends and pages. 

This bar will on the top right will give you alerts. Alerts tell you when 

something is new. 

 

 

You have an alert. Example: 

comment on a post or like on a 

picture 

Someone wants to 

be your friend on 

Facebook 

You have a 

message 
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How do I change my Facebook status? 

You can put a status up on your profile. 

A status is something you post about your day. 

You can decide if you want to do this or not. 

Facebook will ask you  

 

Click on this to type your status. 

 

Activity #18 – Add a Status to My Facebook Page 

1. Click in the status box. 

2. Type in has joined Facebook in the status box. 

3. Click on Photo/Video under the status. 

4. Pick your Good Day photo. 

5. Click on Feeling/Activity under Photo/Videos. 

6. Click Feelings andthen choose a feeling.  

7. Post your status. 

8. It will show up on your wall. Your wall is 

where all the things you show in your profile go.  

Friends can check your wall to see your posts. 
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How do I add friends? 

You can search for people or places you know and add them. 

Click the Search box to look for people. 

Type in a person's name. 

If you find the right person, click Add Friend beside the name.

  

How do I join a group? 

Some groups have Facebook pages, and you like them.  

This is different than being a friend.  

Groups have pages to give you information about events. 

You can make comments (type something) about what they post. 

If you search and find a page, you can Like that page to follow it. 

 

How do I send people messages? 

People can send you messages on Facebook. 

You can write back. 

This is done in Messenger.  

Status on wall 
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Click on the word bubble to go to Messenger. 

You will see your message. Click on it. 

Read your message. 

 

Type in the box in the middle, bottom of your screen. 

Read it over. Click Send. 

 

What is Home on Facebook? 

Facebook Home is where you see what your friends are doing.  

You can like their posts or make comments. 

You can share a post that you like to your own wall. 

 

 

 

 

How do I decide who can see my status and my photos? 

Click on the down arrow and pick Settings. 

 

 

 

Click to 

like a 

post. 

Click to share a 

post your wall. Type post. Read it over. 

Press the Enter key to 

send. 
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Click on Privacy.  

Click on Edit to set your privacy. 

Click Timeline and Tagging on the left side. 

Click on Edit. 

If you pick Friends, then only people you add to your Facebook will be 

able to see your wall and posts. Picking Friends is the safe choice. 

 

Want to learn more about social media? 

 

 

 

 

 

Type this website into your address bar: 

https://edu.gcfglobal.org/en/topics/social

media 

 Please finish page 16 of your 

workbook. 

https://edu.gcfglobal.org/en/topics/socialmedia
https://edu.gcfglobal.org/en/topics/socialmedia
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Learning about Smartphones 
Words in this lesson: 

 

 

 

 

Mobile devices are something you can take with you, away from your 

desk, like:  

Smartphones 

 

 

 

 

Tablets 

 

 

They have touch screens. You use your fingers to type or tap what you 

want to do. You can hold your finger down to slide it, to swipe to open 

your phone or to zoom. 

What are smartphones? 

A smartphone is a computer, phone, and camera. 

 

 

Data  Mobile Device Smartphone Swipe

  

Tablet Texting  Wi-Fi   Zoom 
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A smartphone does more than a cellphone 

Cellphone Smartphone 

• Voice calls 

• Texting 

• Contacts 

• Voice calls 

• Texting 

• Contacts 

• Internet Access 

• Photos and videos 

• Notes 

• Emails 

• Video chats 

• Apps and games 

A smartphone has an operating system just like a computer. 

You can go online with your smartphone using Wi-Fi or a data plan. 

Wi-Fi helps you get online. If you are close to free Wi-Fi (like in the 

library), you can go online on your phone for free. 

Go to Settings on your smartphone 

You will see this: 

Swipe (hold your finger down and move over) or touch to turn on Wi-Fi. 

 

 

               

  Pick a Wi-Fi network to connect to (use). 

Free Wi-Fi may not ask for a password. With some Wi-Fi, you need to 

ask for the password to put in when you use it. 
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What is a data plan? 

A data plan allows you to connect to the Internet from your 

smartphone when there is no Wi-Fi.  

You purchase a data plan. Different plans allow you to use different 

amounts of data. 

Companies use towers to give you data. 

It can cost a lot if you do not keep track of how much data you use, for 

example $100 for 1 GB of data. 

Do I need a data plan? 

Not everyone needs to go online. If you have Wi-Fi at home or work or 

go to the library to use your phone, then you do not need a data plan. 

You will need data if you check your email, use Google, maps, or 

Facebook away from a Wi-Fi signal. 

How do I choose a data plan? 

Large data plans mean you can use as much data as you want. It can 

cost a lot, but you do not have to worry about being charged for using 

too much. 

*Ask the person selling you the phone how to check your data. Check it 

a lot to make sure you do not go over. When you use more data than is 

allowed in your plan, you pay a lot more. 

If you use more data than is in your plan, you can always call the 

company and pay for more data.  

If you want a data plan, look at more than one company and their 

prices before you pick one.  
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How do I pay for a data plan? 

If you are worried about using too much data, you can get a pay as you 

go phone.  

A contract phone gives you a plan that you pay month to month.  

Features Pay-as-You-Go Mobile Contract 

Cost 

 

You pay for the phone 
when you buy it. 
You buy phone cards to 
pay for your plan. 

Phone costs nothing at first. You 
pay for it each month. 

Credit check 

 
 

You do not need a credit 
check.  

Store will check your credit to 
see if you can have the contract 
or ask for deposits for the 
contract. 
 

Data 
 

If you go over your data 
plan, you will only be able 
to use data until your 
phone card is out of 
money. 

If you go over data, you will be 
charged on your monthly bill. 

Choices 

 

There are fewer cellphone 
companies to choose 
from.  

There are many phones to 
choose from. Plans are based on 
cost of smartphone. 

Responsibility 

 

You can change 
companies, plans, or 
phones whenever you 
want to buy a new phone. 

Most contracts last 2 years, and 
if you need a new phone or 
want to leave early, there is a 
charge. 
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How do I send an email on my smartphone? 

On phones and tablets, there will be a reply arrow to reply to emails. 

Click on this to reply to the emails you are sent. 

How do I take pictures on my smartphone? 

Smartphones have cameras. 

There will be an app on the phone to use this camera. The icon for it 

might look like one of these:  

 

Click on the camera app to take a picture. 

Your pictures will go to a photo gallery.  

 

 

Your phone comes with a USB cord.  

The easy way to get pictures from your phone 

to the computer is to use this cable. 

Put the cable into your computer. 

Click on This PC/ My Computer or on the folder icon 

on the bottom of your screen. 

 

Choose your phone from the side menu. 
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Click on Internal Storage. 

 

Click on DCIM. 

 

Your pictures are in your camera folder.  

You can move these pictures onto your 

computer. 

 

Activity #19 – Save a Selfie to My Computer 

 

1. Minimize all windows, so you are on your desktop. 

 

2. Take a picture with your phone. If you 

tap the flip screen button you can take a 

selfie (picture of yourself).  

 

Hold the phone with the screen facing you. Tap the camera or circle 

button at the button of the camera screen to take the picture.  

3. Take as many of yourself as you want. You can see yourself in the 

phone. Hold the camera as still (steady) as you can. 

4. Check your Gallery (or My Photos) to see your selfie. 

5. Put the charge cord into your phone. 

*Note: On an iPhone, 

when you plug your 

phone into your 

computer say yes if the 

phone asks: Do you trust 

this computer? 
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6. Plug your phone into the computer with the USB 

cord. 

7. Go to My Computer / This PC to go to your phone. 

 

 

 

8. Click on Internal Storage and DCIM (stands for Digital Camera 

Imaging) and then Camera to see your pictures. 

9. Right click on your selfie.  

10. Click Copy. 

 

11. Minimize the box. 

 

 

12. Move your mouse over the New Pictures folder on the desktop and 

right click. 

13. Left click on Paste. 

14. Look at your selfie in the file. 

 

 

How do I use a picture from my phone on Facebook? 

You can change your profile picture anytime you want. 

Sign in to your Facebook account to do this. 
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Type in www.facebook.com and type your email and password. 

Click on your name to see your profile. 

Click on the picture (koala) and click Update Profile 

Picture. 

Click on + Upload Photos. 

Click on your smartphone. 

Click on Internal Storage. 

Click on DCMI and Camera. 

Click on your selfie. 

Click Open. 

Click on Save. 

Your picture will change to your selfie. 

 

 

 

 

Activity #20 – Change a Profile Picture on Facebook on your 

Smartphone 

1. Type www.facebook.com in your address bar. 

2. Sign in to your Facebook. 

3. Change your profile picture to your new selfie. 

http://www.facebook.com/
http://www.facebook.com/
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Activity #21 – Change a Cover Photo on Facebook on your 

Smartphone 

1. This week, take a picture or find a picture online you want to use for 

your cover photo. 

2. Go to Facebook and sign in.  

3. Click on Update Cover Photo and Upload Photo to change your 

picture. 

 

4. Find the picture you wish to use and click Open. 

5. Save the picture. 

How do I add my friends to my contact list? 

You add people to text or call to your smartphone. 

They can be saved in Contacts (or All Contacts) on your phone. 

On an iPhone, the icon looks like this:   

On an Android phone, the icon is a person:  

You can also find Contacts by tapping on the Phone icon:  

Then tap the Contacts tab:  
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You can add a new contact 

by tapping the plus sign 

in the top, right corner. 

You will see New Contact. 

Click to add First name, Last name and phone number. 

*Put the area code before the phone number. 

You can add other information if you want but you do not 

have to. 

Tap Done. You can now click on that contact and phone 

them or send them a message. 

 

 

 

 

 

How do I send a message from my smartphone? 

Tap the Text icon to send a text. 

Tap the Plus sign. 

Type the name of the person you want to text in the To: area 

Your phone will put in the name from your contact list. 

Use the keyboard to tap the message in the Enter message box. 

 

Edit (change) Contact 

Delete Contact 

Phone Contact 

Text Contact 
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The keyboard is like a keyboard on a computer.  

You can tap the Spacebar to make a space.  

You can backspace to delete text. 

You can tap the up arrow to make a capital letter. 

You can set the language. Right now, this phone is set to EN (English). 

You can tap a button to make symbols or emojis. 

 

Activity #22 – Send a Text to a Friend 

1. Add someone to your contact list. Ask a friend or classmate if it is ok. 

2. Send them a hello text. 

 

Name of contact 

 

Text/Message typing area 

 

Send text 

 

Keypad (text) 
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How do I send an emoji in a message from my smartphone? 

 

 

 

 

Emojis are little pictures of objects. Some show moods, like happy and 

sad. Others are pictures you can use in your text chat. 

You can tap on an emoji to send it to a contact. 

You tap into your Message box and then tap on the emoji key on your 

phone’s text keyboard. 

Tap the emoji and it will be added to your text chat. 

You can tap the abc button to get back 

to your keyboard. 

 

Activity #23 – Send a Message with 

Emojis 

1. Practice sending a text with an emoji 

to a contact. 

2. Find the abc button to go back to 

your keyboard. 

3. Go back to the main screen of your 

smartphone. 
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How do I delete a message from my phone? 

You can delete your messages by tapping the Trash Can icon. 

Then tap the boxes of what you want to delete. 

Click Delete.  

However, this does not delete the 

message on the other person's phone, just 

yours. 

If you do this and do not want to delete, do not 

worry!  

You will get a screen asking you if you are sure. 

 

 

How do I make everything bigger on the screen? 

You can make the print bigger on the screen. 

Move your thumb and finger out (away from 

each other) to make the text bigger. 

Move your thumb and finger in (toward 

each other) to make the text smaller. 

 

 Please finish pages 17 and 18 of 

your workbook. 
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Learning about Tablets 
 

Tablets have touch screens just like 

smartphones. 

LTE compatible tablets come with payment 

and data plans. They can connect for free to 

any Wi-Fi in the area. 

iPads are made by Apple and have a different 

operating system. 

They have iOS not Windows. 

Other tablets use Windows. 

It is good to look at prices at different stores and ask about sales when 

buying a tablet. 

You use the Internet on a tablet or smartphone just like you do on a 

computer. 

You tap Google to go online. 

You tap the address bar to type in the web address. 

You tap the on-screen keyboard to type. 

Some websites may look different on a tablet or phone. 

Apps are important on mobile devices. 

You tap an app to use a program. 

A tablet also has a camera like a smartphone. 
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How do I buy an app for my iPad or iPhone? 

 

If you have an iPad or iPhone, you will find apps at the App store. 

Some of these apps are free. 

Your phone or tablet will come with the icon to go to the App Store. 

Tap this icon. 

You must be online to go there.  

You can get many free apps here. 

You will have an Apple ID to use this. 

Go to: https://appleid.apple.com/# on 

the computer to get an Apple ID. 

It is a lot like when you made your Gmail account.  

 

Fill in the 

boxes. 

You will 

be asked 

for your 

first and 

last name. 

 

 

You can use your new Gmail account to join. 

You will have to pick 3 security questions from a drop-down menu. 

https://appleid.apple.com/
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This is in case you forget your 

password. 

Write these and your password 

down. 

Hint: Use capitals for the start of each 

answer.  

You may also be asked: Are you a robot? 

You will be asked to put in a code or click on pictures. 

Sites use codes or pictures to make sure that you are a real 

person using the Internet and not a computer. 

CAPTCHA made these tests that are easy for humans but 

hard for robots. 

It is for your own safety. 

 

Type the code into the box and click Continue. 

A code will be sent to your email to put in the box. 

Open a new tab (right click on the tab at the top) to check your email. 

Pick New tab from the drop-down menu. 



76 
 

 

Type gmail.com into your address bar in the new tab and check the 

code. Write it down. 

 

Left click on the Apple tab to go back and type 

it in. 

Click Continue. 

This is the ID will you use for the App Store. 

Tap the App Store icon on your iPad or 

iPhone. 

Put in your new App Store ID (email and 

password). 

Search for the apps you want. 

Example: If you want free games, search for Free Games in the App 

Store search box. Tap the icon to get the app. 

If you want the Facebook App, search for Facebook. 
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When you find the app you want, tap Get  then tap Install.  

 

How do I buy an app with Google Play? 

Other smartphones and tablets use Google Play to download apps.  

You use your Gmail account for Google Play. 

 

Tap the Google Play icon on your phone or tablet. 

Sign in with your new Gmail account. 

Search for free games. 



78 
 

 

Tap Install. 

 

How do I turn Wi-Fi on and off? 

On an iPad, you can see your setting by putting your finger down 

on any part of the screen (with no icons on it) and moving it down 

(swipe). 

A search screen comes up. 

In the search box, type 

Settings. 

This is where you can turn your 

data and Wi-Fi on and off.  

Click on Wi-fi on the left hand 

side and then use your finger 

to slide the bar on. 

You can play around with it. It 

is okay to look through it and 

see what things do. 

The Settings icon on Android smartphones and tablets looks a gear. 
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Click on it to look at the settings on your phone or tablet. 

Activity #24 – Look at Your Settings 

1. If you have a tablet or smartphone, look at all the apps and at the 

settings. 

2. You can see what you have on your tablet. 

3. Press the circle button to go back to the main screen if you need to. 

 

Want to learn more about smartphones and tablets? 

 

 

 

 

 

  

Type this website into your address bar: 

https://edu.gcfglobal.org/en/topics/smartp

honesandtablets/ 

 Please finish page 19 of your 

workbook. 
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Learning about YouTube 
 

You can get the YouTube App on your phone or tablet. 

You can go to it online. 

The web address is www.youtube.com. 

YouTube is a site where you can watch videos that other people have 

posted. 

You can subscribe to videos you want to find 

later. You can like or dislike videos. You can 

share them on Facebook too. 

 

When you are in your Gmail account, you can go to  

YouTube by clicking on the waffle icon (Google apps 

button) 

Use the search box to look for videos on YouTube. 

 

YouTube will show you videos that match your search. 

 

Most smartphones and tablets come with the YouTube App. 

 

http://www.youtube.com/
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Learning about Skype 
 

You can talk to people face to face over the Internet with 

Skype. 

You can use your camera on your laptop, smartphone, or tablet. 

If you use a desktop computer, you will have to get a webcam to see 

people on Skype. 

You can search on your computer to see if Skype is on it. 

 

 

If it is not on it, you will need to download it. 

On a tablet or smartphone, you can do this in the App 

Store or Google Play. 

You can also type Skype into the search bar at Google.ca 

and download it online. 

 

You can use your Gmail account to sign in to Skype. 

 

  



82 
 

Activity #25 – Learn about Skype on YouTube 

1. Open Google Chrome. 

2. Type www.youtube.com. 

3. Type Learning Skype in the search box. 

4. Watch one or two of the videos about Skype. 

5. Use the back arrow to go back. 

6. Take notes if you want to. 

   

 

 

 

 

 

 

 

 

 

 

Ask your 

instructor about 

Milestone #14 

 Please finish page 20 of 

your workbook. 

http://www.youtube.com/
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Learning about Online Safety 

What is a computer virus? 

 

A computer virus is a program that hurts your computer. 

Viruses can: 

 Change or delete things on your computer 

 Erase everything on your computer 

 Attach to your email and spread to other computers  

It is hard to keep your computer 100% safe, but there are steps you can 

take to keep your computer from getting a virus. 

1. Install anti-virus software. You can buy or download this. 

2. Do not open emails from people you do not know. 

3. Do not open anything with a paperclip (attachment) from 

someone in your email if you do not know what it is. There is a 

chance it could have a virus. 

4. Do not download (save things from sites) that you do not know or 

trust. 

5. You can get a virus on any device that goes on the Internet. 
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Where can I learn about online shopping? 

 

 

 

 

 

 

 

It is also important to be careful if you decide to use the Internet to 

shop for items.  

Type these links into your browser to learn more about shopping 

online. 

http://www.bbc.co.uk/webwise/topics/living-and-

interests/shopping-online 

 

http://digitalunite.com/guides/shopping-banking/online-

shopping/how-shop-safely-online 

  

Want to learn about privacy and data tracking? 

Companies keep track of what you click by leaving bits of 

information on your computer. To find out more about cookies 

and data tracking, type this website into your address bar: 

https://edu.gcfglobal.org/en/internetsafety/understanding-

browser-tracking/1/ 

http://www.bbc.co.uk/webwise/topics/living-and-interests/shopping-online
http://www.bbc.co.uk/webwise/topics/living-and-interests/shopping-online
http://digitalunite.com/guides/shopping-banking/online-shopping/how-shop-safely-online
http://digitalunite.com/guides/shopping-banking/online-shopping/how-shop-safely-online
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Personal and Private Information Online 
 

Be careful what you share online. 

People can pretend to be anyone on the Internet. 

Sharing personal information is safe online. 

Private information is not safe online. 

*Remember the government and the bank will never email or text you 

to ask for private details.  

Here are examples of personal and private information. 

Do not share private information online. 

Personal Private 

• Your age 

• Your favourite food 

• If you are male or female 

• If you have sisters or 

brothers 

• Your opinion on an issue 

• Your friends’ first names 

• What music you like 

• If you have pets 

• Your last name 

• Your birthdate 

• Your mother’s maiden name 

• Your social insurance 

number 

• Your passwords 

• Credit cards or banking 

numbers 

• Your street address 

• When you are going on 

vacation 

• Where you work or go to 

school 

• The full names of family or 

friends 
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 Please finish pages 21 of 

your workbook. 

What goes online, stays online! 

These pictures and posters have tips that help  

you keep a good reputation online.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Do not steal other 

people’s ideas 

It is easy to check 
Netiquette 
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Learning about Microsoft Word (MS Word) 
Words in this lesson: 

Word is a program used to make documents. Documents are 

letters, resumés, and flyers.  

 

(Word sections modified from: Essential Skills for Word Processing 2016, TR Leger School, STEP 

Program, UCDSB) 

Click the Window icon in the bottom left corner. 

 

Find the MS Word icon and click on it.

 

 

  

Word will open on your 

computer: 

 

 

 

Document    Font     Ribbon   Tab  

Template    Tools    USB 

http://commons.wikimedia.org/wiki/File:Windows_Phone_7.5_logo.svg
http://commons.wikimedia.org/wiki/File:Windows_Phone_7.5_logo.svg
https://creativecommons.org/licenses/by-sa/3.0/
https://creativecommons.org/licenses/by-sa/3.0/
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What are tabs and tools? 

 

Your Microsoft Word Tools are on the top of your page.  This area 

called the ribbon.  

Tools on the ribbon help you in Word.   

You click the tabs to get to your tools. 

 

For tools to help you with the colour and size of your letters, click on 

the Home tab. 

 

For putting pictures or links in your document, click on the Insert tab. 

 

For checking your spelling or adding a comment, Review tab. 

 

 

If you click on something you put into your document, like a picture or a 

table, you will see a new tab show up on the ribbon. It will go away 

once you have deselected (clicked off) the object.  
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How do I make a new document? 

A new document is like writing on a paper. 

Click on your File tab.  

Click New.  

Click blank document to open the page. 

 

                

How do I close a document? 

Click on File tab.  

Click on Close.  

You will see this: 

 

To save your document, click Yes. If you do not need to save your 

document, click No. To stop closing the document, click Cancel. 

 

How do I save the document to my computer? 

To save a document to the Documents folder on the computer, go to 

the File tab.  

 

 

Click Save as.  
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Click on Browse. 

Click on Documents from the side menu. 

 

 

 

 

Click beside File name. 

 

Type the name you would like to call your file. 

Click Save. 

Wait as the computer saves your file. 

*  You should save your work as you go, about every two minutes. 

*  Once you have saved your work with a name, click the Save icon 

by the File tab to save changes. 

  

Save 

Use scroll bar 

to find 

Documents. 
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Activity #26 – Practice Saving 

1. Open a new Word document. 

2. Type your name. 

3. Click Save As. 

4. Save to Documents. 

5. Type My Name in the File name bar. 

6. Click Save. 

 

How do I save a document to a USB memory stick? 

Put your memory stick into the USB port in your computer. 

Click on the Save As icon beside the File tab.  

 

 

1. Click on Removable Disk on the left-hand side. 

                            

Note: The USB drive name may a company’s name and  

not be labelled  “Removable Disk.” The USB drive will always 

have this beside it to help you find it.  

2. Scroll down. 

3. Double click on the USB drive.  

4. Click in the File name box. 

5. Delete everything in the File name box. 

http://www.google.ca/url?sa=i&rct=j&q=removable+disk+drive&source=images&cd=&cad=rja&docid=CRSgWKG_aLlhSM&tbnid=X1kVB-YrzwJidM:&ved=0CAUQjRw&url=http://www.mydigitallife.info/how-to-disable-write-access-to-usb-hard-disk-and-flash-key-drives/&ei=FKuoUfDWJa_D4APqz4HYAg&bvm=bv.47244034,d.dmg&psig=AFQjCNFlp3xTHi01wmmMOup7HVBOBnaWFA&ust=1370094732883583
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6. Type the name of your file. 

7. Click                  . . 

 

How do I open a document from my computer? 

Click on the little folder icon at the top of your screen by your File tab.  

 

 

 

 

Select Documents from the side menu. 

 

 

 

 

 

 

Click on the file you wish to use here. 

                         

 

 

Click Open. 
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How do I open a document from a USB memory stick? 

Click on the File tab and click on Open.  

         Click on Browse. 

Scroll down the menu on the left side. 

                            

You will see an icon like this:  

Click on the USB drive.  

Select the Word file you want to open (on the right). 

Click Open.  

 

Activity #27 – Save a Document to a USB 

1. Type the name of your country in a Word document. 

2. Save on a USB under “My country.” 
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3. Close Word. Click the X in the top right corner. 

4. Open Word. 

5. Open the My Country file. 

How do I change what the letters look like (the font)? 

A font is the type of the text that you use. 

Choosing a font will change the way letters (the type) will look on your 

screen. 

 

This is a Bookman Old Style font. 

This is a Lucida Handwriting font. 

This is an Arial font. 

This is the Calibri font. 

When you want to change your font, go to the Home tab.  

 

Select the words you want to change by highlighting them.  

Click the downward arrow  beside the font name. 

 

 

 

Use up and down arrows 

to look through the fonts. 
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As you move your pointer over the font names, your word will change 

to show you what that font will look like. Click on the font that you 

want. 

How do I make the font bold or italic? 

 

 

 

This is where your font styles are located. 

This is bold. 

This is Italic. 

This is underlined. 

Select the words you want to change by highlighting them. 

Click on the letter of what you want to do. 

To make a word bold, click the B. 

To change the word to italics, click I.       

To underline, click U.      

To undo, just click the B, U, or I again and it will change back.  

To change the style of underline you want to use, click 

the down arrow beside the U.       

 

Click on the type of underline that you want. 
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How do I change the size of my letters? 

You can change the font size by the number beside the font name. 

The standard size is 12 but you can make it bigger or 

smaller. 

This is size 8. 

This is size 12. 

This is size 20. 

To change font size, select the words you want to change by 

highlighting them. 

Click on the down arrow beside the font size.  

Click on the font size you want. 

How do I change the colour of my letters? 

 

You can change the colour of the font. 

Select the words you want to change by highlighting them.  

Click on the down arrow beside the A with the underline.  

You will see the font colours.  

 

Click on the box of the colour you want. If you do 

not like that colour, you can choose a new one. 
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Activity #28 – Change the Colour of the Words 

1. Write a note to a friend or family member thanking them for 

something that he or she did that you liked. 

 

2. Select their name by highlighting it. 

 

3. Change the font colour to blue. 

 

4. Change font size to 24. 

 

5. Change the font of the note to Lucida Handwriting. 

 

6. Save as “Letter” to Documents on the computer. 

How do I undo changes and go back to how things were? 

 

If you make a mistake you can change it back by clicking Undo. 

Undo will change the last thing you did. 

You can click Redo if you click undo and did not want to. 

Undo and Redo are at the top left-hand of the screen. 
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To undo, click  

 

To redo, click  

 

Activity #29 – Practice Undoing and Redoing 

 

1. Type the word:                        document 

2. Change the font:                     document  

3. Undo            document 

4. Redo             document 
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How do I print my document? 

 

   

You can print your documents from your screen to paper in Word. 

1. Click on the File Tab.  

 

2. Click on Print from the drop-down menu.  

Use the drop-down menu to pick how you want the document to print. 

  

  

 

 

 

 

3. Click Print.  

 

 

Select number of copies. 

 

Select printer. 

Select what pages to print. 

Select printing on one or 

two sides of the page. 
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How do I check the spelling of my document? 

 

If a word is misspelled, you will see a red squiggly line under it. 

 

 

 

To check the spelling of the document, click the Review tab. 

 

Click Spelling & Grammar. 

 

 

You will see a screen like this one at the right side of 

the screen: 

 

Choose the word that you want from the list of suggestions. 

 

Click                       . 

 

When you are done, click OK. 
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Activity #30 – Using Spell Check 

1. Type this into a Word document: 

 

I am lerning abut computurs and I lorve it.  This is so much fun to lern. 

 

2. Check the spelling of this sentence. 

 

How do I check the spelling of one word? 

You can right click with the mouse on a word to get suggested 

spellings. 

You can do this with grammar mistakes too. You will be given 

ideas of what the right spelling or grammar should be. 

Right click to see spelling and grammar help. 

 

Left click to choose the new word. 

This suggestion also shows you what the word means. This will 

help you pick the right word. 
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How do I move words around, copy, paste or cut them? 

 

 

 

Copying words 

Pick the words you want to copy by highlighting them. 

Click on the Home tab.  

Click on Copy. 

Moving Words from One Place to Another 

Pick the words you want to cut by highlighting them. 

Click on Cut.  

The words will go away. 

Click to the place in the page where you would like to put them. 

Click Paste.  

 

Activity #31 – Deleting Words in a Document 

1. Type your name in a Word document. 

2. Make it bold and underlined. 

3. Select the words by highlighting them. 

4. Click on Cut. 

5. Click on Paste. 
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How do I make a thank you card?  

Word has already started some documents that people might use a lot.  

MS Word calls these templates. 

 

 

 

 

 

 

You can search for any template and use it to make what you need. 

Click File. Click New. Type thank you card in the search box. 

 

Click on the one that you wish to use, then click Create. 

You can click on the text in the template and type your 

own words, if you want. 

Print and save your thank you card.  
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Activity #32 –Looking at a different template 

 

1. Go to File. 

 

2. Go to New. 

 

3. Search for an online template in the search box. 

 

4. Type basic resumé in the search box.  

 

5. Click on a resumé. You can pick the one you think looks good. 

 

6. Click Create. 

 

*You do not have to work on this resume 

now, just know that these types of documents can be searched in 

templates. 

7. When using any template, delete any parts you do not want by 

highlighting them and pressing the Backspace key. Have fun with it. 

 

8. Use Undo if you make any mistakes.  
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Learning about Notepad 
 

If you do not have MS Word, you can type 

documents in Notepad. 

Notepad is on your computer. 

You can search for it at the bottom of your screen.  

 

You type in the white box. 

You can select words by highlighting 

them to make changes. 

You can change the font by clicking on 

Format and then Font. 

 

You can save and 

print your work by 

clicking on File. 

 

 

 

There are fewer options in Notepad than there are in MS Word.  

 Please finish pages 22 and 23 of your 

workbook. 
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Final Activity, Part 1 – Save Files and Documents to Your USB 

Now that you are finished this course, you can save your files from the 

computer to your USB. 

1. Find your New Pictures folder on the desktop 

2. Put your pointer right on top of the file and right click. 

 

3. Choose the Send to option from the menu. 

4. Slide over and click on your USB.  

 

You can do this with documents too. 

5. Click on This PC. 

6. Click on Documents.  

7. Right click on your “letter” document from the MS Word lesson. 

 

8. Click Send to and your USB. 
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Final Activity, Part 2 – Find an Inspirational Quote Online 

 

1. Open Google Chrome. 

 

2. Search Google images for a “Success Quote.” 

 

3. Choose a quote that you like from the results. 

 

4. Print the quote out for yourself, you deserve it! 

 

5. Congratulate yourself on a job well done. 
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YOU DID 

IT! 

Congratulations 

on your new 

digital skills! 

 Please finish page 24 of your 

workbook. 


